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Announcements

ServiceGuard Manager is the graphical user interface for ServiceGuard
product. With it, you can view and monitor clusters managed by
MC/ServiceGuard, ServiceGuard Extension for RAC, MetroClusters, and
Continental Clusters. You can also issue common administrative
commands.

ServiceGuard Manager replaces ClusterView. It can be launched
independently, or from OpenView or ServiceControl Manager.

If you connect to a server running ServiceGuard A.11.12 or later, you can
see maps of clusters from local or remote management stations that are
running HP-UX, Linux, or Windows.

You can also do common administrative commands through the interface
if you connect, with root permission, to an HP-UX server with
ServiceGuard A.11.14 or later. These actions are:

= You can run or halt a cluster, node, or package
= You can move a package to a new node
= You can change package- and node-switching flags

Even if you cannot see a particular object in your current map view, an
icon on the toolbar warns you about new problems. High-availability
alerts are posted when ServiceGuard Manager polls. The Alerts window
has aids for analyzing the problems.

If your HP-UX cluster nodes are configured for SNMP, you can receive
their SNMP cluster trap messages in the SNMP Browser window. You
can set your management station as a trap destination from a tab in the
window. Messages can be sorted and re-organized.
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What's in this Version

Version A.03.00.01 is a minor update of ServiceGuard Manager. It has
the same functionality as version A.03.00 (see below). The only change is
that it now supports ServiceGuard 11.15 and SuUSE Linux. (SUSE is
available only in English.) In this document, information about A.03.00
also applies A.03.00.01, unless specifically noted. To see what version
you have, go to the Help menu and select “About.”

ServiceGuard Manager, version A.03.00 and A.03.00.01, can be installed
on HP-UX, Linux, and Windows. All platforms are available from the
web at software.hp.com, or are delivered on CD ROM:

< Product B8325BA software and license for HP-UX
e Product T1228BA software and license for Linux
e Product B8341BA software and license for Windows

Now, ServiceGuard Manager interface is now available in 5 languages:
< English

= Japanese

= Korean

< Simplified Chinese

= Traditional Chinese

With version A.03.00 and later, you can see clusters on more than one
subnet. One instance of ServiceGuard Manager can display several
sessions, where each session represents a connection to a Cluster Object
Manager. Hewlett-Packard supports up to 10 connected sessions in one
instance of ServiceGuard Manager. One new property sheet shows
information about all sessions in the map. Also, each session now has its
own property sheet.

With version A.03.00 and later, an Alerts icon on the toolbar can show
you the most critical problem in all the cluster objects on the map,
whether they are visible at the moment or not. Click the Alerts icon, and
you see a window with a table of all alerts, problems with clusters, nodes,
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and packages. These are gathered and updated by ServiceGuard
Manager each time it refreshes. In the Alerts window, you can filter and
order the messages for help in troubleshooting.

Performance has improved again.

With version A.03.00 and later, problems with ServiceGuard Manager
are presented as they occur, and no longer silently added to log files.
When you see an error window, click the “details” button to see the log
messages. You will see directions there telling you how to report the
problem.

ServiceControl Manager Version 3.0 now launches ServiceGuard
Manager A.03.00 or later, with for ServiceControl Manager.)

OVO 7.0 now integrates ServiceGuard Manager A.03.00 and later.

Accessibility has been improved. See the “Accessibility” topic in the Help
Table of Contents, under “Using ServiceGuard Manager.”

What You See

The figure below shows an instance of ServiceGuard Manager with three
sessions. The icon by the connection to COM mango shows that the user’s
role is view-only for those clusters. In the first and last sessions, an icon
shows the user can do administrative commands.

The Alerts button tells you there is information about serious alerts. We
can see some red-bordered clusters that are down. Also critical are the
clusters that have a package icon with a red cross, showing they have
packages that are down.
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ServiceGuard Manager: All Sessions View
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With ServiceGuard Manager, you see your ServiceGuard clusters three
ways.

In the map on the right pane, you can see configuration relationships
by the position of objects in the diagram. You can see status from the
colors and symbols. You can also get a small text message about the
status if you pause the mouse over a cluster object.

In the tree on the left pane, you can see cluster relationships listed
hierarchically.

You can navigate through the map by clicking an object in the tree.
The map pane will show information relevant to the object you
clicked. For example, if you click a node, you see that node only, its
cluster, and the packages configured to run on it.
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= In Properties, you see more detailed information about any session,
cluster, node, or package on your map. To open Properties, select an
object, then go to the menu on top. Or right-click an object and use
the pop-up menu.

You can save a record of your clusters. For example, you could document
a newly configured cluster. If that cluster has problems later, you could
easily compare the original and current states. Launch two instances of
ServiceGuard Manager. Open the saved file in one, and connect “live” in
the other. You can navigate both maps, and open equivalent property
sheets for comparisons. Messages in the Events Browser are not saved
in.sgm files.

The following screenshot shows one of the clusters in Fig. 1.1. The
session was saved as screenshotNoir.sgm. When opened, the user
navigated to the star cluster for this view.

Figure 1-2 ServiceGuard Manager View of One Cluster
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This is a saved view of the cluster Star, seen in Fig 1.1. You can see the
no-failover alert on the cluster refers to pkg2. Details about the cluster
lock alert are in the Cluster Properties in the Quorum Server tab. The
8
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red Alerts button on the toolbar tells you that there is a serious problem
in some cluster. Even though you don’t see that cluster now, you could
click Alerts and get information about it from the Alerts window.

How it Works

You install ServiceGuard Manager on a management station. This can be
HP-UX, Linux, or Windows.

From the management station, you connect to a server with COM
(Cluster Object Manager) software on a ServiceGuard node (HP-UX or
Linux). (The COM is installed as a part of ServiceGuard.) Each server
connection is displayed on the interface as a session.

You tell the COM server to go out on its subnets, and discover
ServiceGuard nodes configured for these types of clusters:

= MC/ServiceGuard, Version A.10.10 and later

= ServiceGuard Extension for RAC, Version A.11.14 or later
= ServiceGuard OPS Edition, Version A.11.08 and later

< LockManager, Version A.11.02 and later

= MetroCluster, all versions

= Continental Clusters, all versions

If you use a valid logon and password for a COM server with
ServiceGuard A.11.12 or later, you get viewing permission.

To do administrative commands, you must log in as root on an HP-UX
server with ServiceGuard A.11.14 or later and Cluster Object Manager
Version A.01.03.01 or later. (See "Required and Recommended Patches”
in this document.)

The server queries ServiceGuard nodes on its subnet for status and
configuration information. If the server has access permissions, the
cluster node will supply the information. (See “Before Installing
ServiceGuard Manager,” below, for a description of configuring node
access permissions with cmclnodelist )

This information is used for the map, tree, and properties. Any status
alerts are posted in the Alerts window.
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Note: Because Continental Clusters are always on more than one subnet,
ServiceGuard Manager sees them as two clusters. To see all the
information about a Continental cluster, open two separate sessions,
connecting to a COM server on each subnet.

What Documentation is Available for This Version

These Release Notes will help you install ServiceGuard Manager.

Once ServiceGuard Manager is running, online help has the information
about how to use the interface. Start with the Help topic “Using
ServiceGuard Manager.”

Documentation for the ServiceGuard products themselves is available at
http://www.docs.hp.com and is updated regularly. Click High Availability,
then scroll through the alphabetical listings.

You will find two manuals for ServiceGuard:

< Managing MC/ServiceGuard
= Configuring OPS clusters with ServiceGuard OPS Edition

Two manuals are specifically for ServiceGuard on Linux:

e Getting Started with ServiceGuard on Linux
= ServiceGuard for Linux

You will also find Release Notes for the following:

= MC/ServiceGuard

= ServiceGuard for Linux

= ServiceGuard Extension for RAC

= ServiceGuard OPS Edition (formerly MC/LockManager)
= MetroCluster

= ContinentalClusters

= ServiceGuard Manager (see end of ServiceGuard list)

You can order the book Clusters for High Availability: A Primer of HP
Solutions, second edition, by Peter Weygant (HP Press: Prentice Hall,
ISBN 0-13-089355-2). This guide describes basic cluster concepts. To see
information about this retail book, go to http:/Aww.hp.com/hpbooks/

and click search, then enter the first few words of the title.

10
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For information about HP-UX, go to: http:/mww.docs.hp.com and
scroll to HP-UX in the alphabetical listing.

For information about Red Hat Linux, go to http:/Aww.redhat.com
For information about SUSE Linux, go to http:/mww.suse.com

For information about HP OpenView Operations, I T/Operations, and
Network Node Manager, refer to:
http:/mmww.docs.hp.com/hpux/netsys

Further Information

Additional information about ServiceGuard and high-availability topics
may be found on HP’s web pages: http:/mww.hp.com/hpux/ha (High
Availability) and http:/imww.hp.com/linux (Linux-specific).

Also see http:/Avww.hp.com/go/ha

Support information is available from the Hewlett-Packard IT Resource
Center at:

http://itrc.hp.com (US and Asia Pacific)
http://europe.itrc.hp.com (Europe)

To receive the latest news about recommended patches, product support
matrices, and recently supported hardware, go to the IT Resource Center
site above, and subscribe to the High availability programs tips and
issues digest.

The most recent versions of users’s guides and white papers are available
on Hewlett-Packard’'s documentation web pages:
http://docs.hp.com/hpux/ha (High Availability) and
http://docs.hp.com/linux (Linux-specific)
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Compatibility Information and Installation
Requirements

Before you begin an installation, read this entire document and any
other Release Notes or READMESs you have.

The following tables summarizes the compatibility and requirements of
the different releases of ServiceGuard Manager.

Table 1-1 Compatibility: ServiceGuard Manger A.01.00 (Oct 00)
SGManager: COM Discovered
(Cluster .
Hardware and ; ServiceGuard Comments
Object
Software Clusters
Manager)
S700/S800 Work- | COMA.01.01 | SG A.10.10 or later | Shows users a tree, graphic
station with (SG A.11.12) Metro Clusters. all | M&P of clusters, nodes, and
HP-UX 11.x. ' packages.
. Continental .
Windows NT 4.0, Clusters, all Includes basic property sheet.

Windows 2000
Professional

Can export static cluster map
as .sgm file, and a graphic of

Edition . -
map as ..jpg or .gif
Table 1-2 Compatibility: ServiceGuard Manager A.01.01 (Dec 00)
SGManager: COM (Cluster Discovered
Hardware and Object ServiceGuard Comments
Software Manager) Clusters

S700/S800 COMA.01.01(SG | SG A.10.10 or later Added: automatic
workstation with or SG OPS SG/OPS. all polling, new connection
HP-UX 11.x. Edition, A.11.12) ' dialog including scoping,

Windows NT 4.0,
Windows 2000
Professional
Edition

LockManager 11.02
Metro Clusters, all

Continental
Clusters, all

refreshable property
sheets.

Japanese version
available.

12
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Table 1-3 Compatibility: ServiceGuard Manger A.01.02 (Jun 01)
. Discovered
SGManager: COM (Cluster ServiceGuard
Hardware and . Comments
Object Manager) Clusters
Software
Added: Red Hat COM A.01.01 (with SG A.10.10 or later Added support for

Linux 7.1 (kernel
version 2.4.2.)

S700/S800
workstation with
HP-UX 11.0 and
11.11

Also Windows 2000
Professional
Edition or NT 4.0
or later

SG or SG OPS
A.11.12)

or A.01.03 (with SG
or SG OPS A.11.13)

SG OPS Edition, all
LockManager A.11.02
Metro Clusters, all

Continental Clusters,
all

System Multi-node
Packages.

Usability
improvements for
icons and badges,
menu and toolbar,
property sheet.
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Red Hat Linux 7.1
(kernel version
2.4.2)

Windows NT 4.0,
Windows 2000
Professional

COM A.01.03 (SG
or SG OPS 11.13,
and Linux 11.13)

Lock Manager
A.11.02

Metro Clusters,
all

Table 1-4 Compatibility: ServiceGuard Manager A.02.00 (Oct 01)
. Discovered
SGManager: COM (Cluster ServiceGuard
Hardware and . Comments
Object Manager) Clusters
Software
S700/S800 Monitor: SG A.10.10 or Basic administration
workstation with later when user is connected to
HP-UX 11.0, COM A.01.01 (SG HP-UX COM as root:
HPOUX 11.11. or 11.12 or SG OPS SG OPS
T Ed 11.12) Edition, all * Run or halt a cluster,

node, and package,
(including system
multi-node packages).

* Move package to another
node.

Edition, or XP Admin: ngsttlgfsnﬁ * Change package/node
Professional COM A.01.03.01 ' switching.
Edition (SG 11.14 or SG For Quorum Server, add a
OPS Ed 11.14)
property sheet, and a
status badge on the map.
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Windows: 2000 Prof,
XP Prof, NT 4.0

Red Hat Linux 7.1
(kernel 2.4.2) Red Hat
AS 2.1

SG Linux 11.13)
Admin:

COM A.01.03.01 (SG
11.14.01, SG OPS Ed
11.14)

Metro Clusters,
all

Continental
Clusters, all

Table 1-5 Compatibility: ServiceGuard Manager A.02.01 (Mar 02)
. Discovered
SGManager: COM (Cluster Object | ServiceGuard
Hardware and Comments
Manager) Clusters
Software
S700/S800 workstation | Monitor: SG A.10.10 or Event Browser
ﬁgr‘ul;'(Pi;Ji(llh%-UX COM A01.01 (SGor | 1ter added.
P SG OPS Ed 11.12) SG Ext RAC, all | Add support
11.22, or Linux Red Hat for OPS
7.1 or greater. Kernel COM A.01.03 (SG or SG OPS Ed, all ackages. with
version 2.4.2 SG OPS Ed 11.13 and . P ges,
SG Linux, all new status

badges on the
map.

Support for
HP-UX 11.22.

Chapter 1

15




ServiceGuard Manager Version A.03.00 Release Notes, Second Edition
Compatibility Information and Installation Requirements

Table 1-6 Compatibility: ServiceGuard Manager A.03.00 (Dec 02)
. Discovered
SGManager: COM (Cluster ServiceGuard
Hardware and . Comments
Object Manager) Clusters
Software
No change: Monitor: SG A.10.10 or Can have several
S$700/S800 COM A.01.01 (SG or | '3te" Séegf\'ﬂogjhflzcet';g;ea‘:h
workstation with SG OPS Ed 11.12) SG Ext RAC, all '
HP-UX 11._0 HP-UX COM A.01.03 (SG SG OPS Ed. all Each session has a
11.11, or Linux Red property sheet.
Hat 7.1 or greater. 11.13 or SG OPS Ed SG Linux, all
i 9 ) 11.13) ' Support for

Kernel version 2.4.2

Windows: 2000
Prof, XP Prof, NT
4.0

Red Hat Linux 7.1
(kernel 2.4.2) Red
Hat AS 2.1

Admin:

COM A.01.03.01 (SG
or SG OPS Ed 11.14)

COM A.02.01.01 (SG
Linux 11.14.02)

Metro Clusters,
all

Continental
Clusters, all

ServiceGuard
Extension for RAC,
with new cluster tab
and distinguishing
cluster icon.

Available in English,
Japanese, Korean,
Traditional Chinese,
and Simplified
Chinese

16
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Table 1-7 Compatibility: ServiceGuard Manager A.03.00.01 (Jun 03)
SGManager: Discovered
Hardware and OE‘S(I:\Q IS/CI:e:rl:eSxteerr) Service- Guard Comments
Software J 9 Clusters
Add SUSE Linux Monitor: SG A.10.10 or Same functionality
$700/S800 COM A.01.01 (SG or | ‘At as A.03.00.00
workstation with SG OPS Ed 11.12) SG Ext RAC, all Support for
HP-UX11.0, HP-UX ServiceGuard
11.11, or Linux: Red gg'géoédofl(fg g"G SGOPSEd, all A.11.15 on HP-UX
Hat 7.1 or SUSE 8 - — SG Linux, all 11.11
Linux 11.13)
Windows: 2000 . Metro Clusters, all | Support for SUSE
. Admin: - .
Professional Continental Linux (SUSE is
Edition, XP COM A.01.03.01 (SG Clusters. all available only in
Professional, NT 4.0 | or SG OPS Ed 11.14) ' English.)
COM A.02.01.01 (SG
Linux 11.14.02)

System requirements

ServiceGuard Manager version A.03.00 and A.03.00.01 can be installed
on a computer with one of the following operating systems:

HP-UX, Version 11.0 or later, except for HP-UX 11.22. ServiceGuard
Manager Version A.03.00 installs on most HP-UX versions. However,
HP-UX 11i version 1.6 (11.22) requires ServiceGuard Manager
Version A.02.01.

Viewing ServiceGuard Manager through Reflection X is not
supported.

Red Hat Linux Advanced Server Release 2.1.

SUSE Linux, SLES (Linux Enterprise Server), version 8, United
Linux version 1.0, with kernel version 2.4.19-64GB-SMP. (SUSE is
available only in English.)

Microsoft Windows XP Professional Edition, Windows 2000
Professional with Service Pack 1 or later, or NT 4.0 with Service Pack
5 or later, and with a video adapter of SVGA or higher resolution.

Chapter 1
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Hardware Requirements

ServiceGuard Manager will run on the HP 700 Series workstations and
the HP 800 Series servers.

ServiceGuard Manager will run on a PC with a Pentium Il 200 MHz or
higher, and a video adapter with resolution of SVGA or higher.

Memory Requirements

Running on HP-UX, these are the minimum requirements for
ServiceGuard Manager:

= 256 MB of available memory
= 65 MB of available hard disk space under /opt
< 1 MB of available hard disk space under /usr

< 1 MB of available hard disk space under /etc/opt/OV if OpenView is
installed.

= 3-15 MB of available hard disk space under var for log files.

Running on Red Hat or SUSE Linux, these are the minimum
requirements for ServiceGuard Manager:

< 128 MB of available memory
< 100 MB of available hard disk space under /usr/local

< 15 MB of additional hard disk space available for log files created
when ServiceGuard Manager is run:

— Red Hat: /usr/local/sgmgr/log
— SUuSE: /opt/sgmgr/log

Running on Windows, these are the minimum requirements for
ServiceGuard Manager:

e 128 MB of memory
= 25 MB of available hard disk space
= 15 MB for log files when ServiceGuard Manager is run.

= Up to 30 MB of additional hard disk space during the installation
process.

18
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Port Requirements

ServiceGuard Manager itself does not need a reserved port.

It communicates with ServiceGuard through the ports reserved for
ServiceGuard in /etc/services and listed as HA Cluster (hacl) ports.

The Event Browser in ServiceGuard Manager can receive messages from
SNMP traps. SNMP requires ports 161 and 162. The list of port
assignments is in the /etc/services file.

Because SNMP uses a single dedicated port, only one application can
receive messages. For more information, open online help and go to
Troubleshooting Clusters, SNMP Problems.

Chapter 1
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Installing and Running ServiceGuard
Manager

Installing Software

You can install ServiceGuard Manager on an HP-UX workstation (with
or without ServiceGuard), on a Linux workstation (with or without
ServiceGuard), or on a PC with Windows XP Professional Edition,
Windows NT, or Windows 2000 Professional.

If a previous version of ServiceGuard Manager is already installed,
uninstall it before installing the new version. See information about
uninstalling below.

Before Installing ServiceGuard Manager

When deciding where to install ServiceGuard Manager, consider the
connections from users to the server nodes, the connection from the
server nodes to cluster nodes, and creating the security you want.

= Which operators will use the interface, and on which computers?

To view a cluster, the ServiceGuard Manager operator needs a logon
and password on at least one server on the cluster’s subnets. The
server is a node with ServiceGuard A.11.12 or later.

To administer clusters on the map, these three things must be true:

— The user is logged in to the server node as root

— The server has ServiceGuard, Version A.11.14 or later installed,
with patches.

— The server node has Cluster Object Manager, Version A.01.03.01
or later.

— The server node must be allowed to interact with the target
nodes.

= Security Considerations

If you are an experienced ServiceGuard user, you may notice that the
way a ServiceGuard Manager user gets information about remote
clusters is similar to the way a ServiceGuard command-line user can

20
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issue the cmviewcl command to get information about a remote
cluster. Using ServiceGuard Manager, certain users can also relay
the most common administrative commands to ServiceGuard
clusters, and the effect is the same as logging into the node and
issuing the command on the command line.

Please notice, however, that the permissions and access mechanisms
are not the same. The ServiceGuard Manager user’s permissions
depend on his login to the server, not the cluster node. It is the server
that interacts with the cluster nodes on the user’s behalf, through the
Cluster Object Manager, a ServiceGuard API.

A ServiceGuard Manager user does not need any direct access to the
target nodes that are displayed in the map. The configuration and
status information is collected by his server node and sent back to
the management station.

The server node always accesses other ServiceGuard nodes as
user=root. The server needs access to the nodes. The recommended
access mechanism is to include the server name or IP address in the
target nodes’ cmclnodelist file. A less secure way is to include the
server node in a target node’s .rhosts  file. Listing in cmclnodelist
limits contact to ServiceGuard; a listing in .rhosts  grants wider
access.

If the user is logged in to the server node as root, the server node will
also display certain common administrative commands in the menu.
The server relays these commands to the clusters in the session for
the users.

If you are updating from an earlier version, think about permissions
on your HP-UX nodes with ServiceGuard Version A.11.13 or later,
with Cluster Object Manager Version A.01.03.01 or later. Any person
who can log in to that node as root may be able to do administrative
commands on any cluster objects on that node’s subnets. If you do not
want access, you can limit the root logins on that node, or limit that
node’s access to particular clusters on its subnets.

Installing Software

You can install ServiceGuard Manager on three platforms: HP-UX,
Linux, or Windows. The methods are slightly different for each. Use the
section below that is appropriate for your type of installation.

Chapter 1
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NOTE

There are two ways to install ServiceGuard Manager: from the HP
ServiceGuard Distributed Components disk, or from this web site:
http:/mww.software.hp.com. You can choose the English, Japanese,
Korean, Simplified Chinese, or Traditional Chinese version.

ServiceGuard Manager installs its own JRE (Java Runtime
Environment™), and can not use any other JRE that may already be
installed.

If you are updating from an earlier version, first uninstall the earlier
version.

If you update from an earlier version of ServiceGuard Manager, your
user preference files will be replaced with default settings. The new
preference files are compatible with architecture changes in
ServiceGuard Version A.03.00 and A.03.00.01. Earlier preferences
cannot be carried over.

ServiceGuard Manager supports system default colors for all platforms.
Most system settings work, but a custom color setup could cause
problems. For example, you may see what seems to be an empty box.
However, when you drag the mouse to highlight it, you may discover that
your system is displaying white font on a white background. If you
restore the system to default colors, you will be able to see things as they
were designed.

Installing ServiceGuard Manager on HP-UX Install Version
A.03.00 or A.03.00.01 of ServiceGuard Manager on a computer with
HP-UX Version 11.0 or 11.11 installed.

Version A.03.00 and A.03.00.01 of ServiceGuard Manager is not
supported on HP-UX 11i version 1.6 (11.22). The ServiceGuard Manager
depot for 11.22 (on the HP Distributed Components Disk or
http://software.hp.com ) automatically installs ServiceGuard
Manager Version A.02.01. The Release Notes for version A.02.01 are on
the HP Distributed Components Disk, and at http://docs.hp.com ->
high availability.

You can install from two places:

= To install from the HP ServiceGuard Distributed Components disk:

22
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. Mount the CD-ROM directory, choosing /SD_CDROM for your

mount directory.

. Enter the swinstall command.

. When the window opens, set Source Depot Type to: LocalCDROM

For Source Depot Path, fill in the appropriate release name. For
example, if you have HP-UX 11.11, use:

SD_CDROM/SGManager/HP-UX/11.11/sgmanager.depot

. swinstall allows you to select: B8325BA A.03.00

ServiceGuard Manager or B8325BA A.03.00.01

ServiceGuard Manager  for HP-UX 11.00 and HP-UX 11.11. (For
HP-UX 11.22, select B8325BA A.02.01 ServiceGuard

Manager ). Select the appropriate platform, then start the install.

To install from the web, go to http://www.software.hp.com. Click High
Availability, then ServiceGuard Manager for HP-UX. Fill out the
information form. A download window opens.

1. Select your operating system from the “Software Specification”

pull-down list. (To see the version of HP-UX, use the uname
command.) Available versions are HP-UX 11.00, 11.11, and
11.22. The 11.22 build will install ServiceGuard Manager
A.02.01, the only version available for 11.22. The 11.0 and 11.11
build will install ServiceGuard Manager A.03.00.

. Download the depot, and store it on your disk, perhaps in the

ftmp directory. To save disk space, you can remove this depot
from your disk when you have finished installing.

. Run the swinstall command on this depot. The user interface

will lead you through the installation (mark, analyze, install).
Select the B8325BA ServiceGuard Manager  product. Depending
on your operating system, choose B8325BA 11.00,

B8325BA _11.11, or B8325BA 11.22 .

After swinstall completes, verify the installation:

1. Is the man page installed? (Enter: man sgmgr )
2. Was the directory created for log files? (Enter: Il /var/opt/sgmgr )

3. Are all the program files in the installation directory? If you install
in the default directory, you should see the following when you enter
Il fopt/sgmgr/*
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= bin

= examples

e jre

- lib

e OV (if HP OpenView is installed)

ServiceGuard Manager installs its own JRE (Java™ Runtime
Environment) and cannot use any other JRE on the computer.

If you are updating from an earlier version of ServiceGuard Manager,
your user preference files are replaced with default settings. The new
preference files are compatible with architecture changes in
ServiceGuard Version A.03.00. Your old preferences cannot be carried
over

If you have Network Node Manager or OpenView Operations installed
on this computer, also see the section below, Installing with HP
OpenView.

For more information about installation procedures and related issues,
refer to the man page for swinstall . Also see the manual Managing
HP-UX Software with SD-UX , which can be viewed or printed from
http://www.docs.hp.com -> HP-UX 11.0 Operating System -> System
Administration.

Installing ServiceGuard Manager on Linux Install ServiceGuard
Manager on a computer that has one of these versions of Linux:

e Red Hat Linux, version 7.1 or later, with kernel version 2.4.2 or later.

e SUSE Linux, SLES (Linux Enterprise Server), version 8, United
Linux version 1.0, with kernel version 2.4.19-64GB-SMP. (SUSE is
available only in English.)

You can install from two places: from a disk or from a browser
= To install from the ServiceGuard Distributed Components CD:

1. Insert the disk and mount the CD-ROM drive. Choose a name for
your directory, for example </SGM_ROM>

2. From </SGM_ROM>/SGManager/LINUX, enter:

— For Red Hat Linux:
rpm -i sgmanager-A.03.00-1.product.redhat.i386.rpm
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or

rpm -i sgmanager-A.03.00.01-1.product.redhat.i386.rpm
— For SuUSE Linux:

rpm -i sgmanager-A.03.00.01-1.product.suse.i386.rpm

e To install from the web:

1. Go to http:/mww.software.hp.com Click High Availability.

Click ServiceGuard Manager in the alphabetical list.

. Save the sgmanager-A.03.00-1.product.redhat.i386.rpm file

to your disk. (To save disk space, you can remove the rpm file
when installation is done.)

. From the directory where you saved the file, run the install

process with this command:

— For Red Hat Linux:

rpm -i sgmanager-A.03.00-1.product.redhat.i386.rpm
— For SUSE Linux (English only):

rpm -i sgmanager-A.03.00-1.product.suse.i386.rpm

After rpm completes, verify the installation:

1. Is the man page is installed? (Enter: man sgmgr )

2. Are all the program file directories in the installation directory? By
default, the Red Hat default directory is /usr/local/sgmgr/ . By
default, the SUSE install directory is /opt/sgmgr/

bin
examples
jre

lib

log

users

ServiceGuard Manager installs its own JRE (Java Runtime
Environment™) and cannot use another JRE already installed on the
computer.
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If you are updating from an earlier version of ServiceGuard Manager,
your user preference files are replaced with default settings. The new
preference files are compatible with architecture changes in
ServiceGuard Version A.03.00 and A.03.00.01. Your old preferences
cannot be carried over.

Installing ServiceGuard Manager on Windows Install
ServiceGuard Manager on a computer that has Microsoft Windows XP
Professional Edition, NT 4.0 (or later), or 2000 Professional installed. If
you currently have an older version of ServiceGuard Manager, uninstall
it first: Start -> Programs -> ServiceGuard Manager -> Uninstall.

You can install from two places:
= To install from the ServiceGuard Distributed Components CD:

1. Insert the disk in the PC's drive

2. Click the Start menu in lower left corner of your screen. Choose
Settings -> Control Panel. Double-click Add/Remove Programs.

3. Click on Install.
4. Navigate to SGManager\Windows. Select sgmanager.exe.
5. Click Finish and follow installation directions.

= Toinstall from the web:

1. Go to http://www.software.hp.com. Click High Availability, then
ServiceGuard Manager.

2. Click on the link under Download Software (sgmanager.exe).

3. You can store the file on your system, or run it directly from the
website. If you download to your system, you can remove it after
installation.

4. On your PC, run sgmanager.exe (or double-click the
sgmamager.exe file in Explorer).

5. Choose a language option. The default install directory is:
C:\Program Files\Hewlett Packard\ServiceGuard Manager\
but you can choose a custom installation directory.

The ServiceGuard Manager icon will appear on your desktop.

Using Windows Explorer, verify that these folders are installed:

e bin
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= examples

e jre
- lib
< log
e users

= ov (if OpenView Network Node Manager is already installed on the
PC)

ServiceGuard Manager installs its own JRE (Java Runtime
Environment™) and cannot use any other JRE already on the computer.

If you have Network Node Manager installed on this computer, see
Installing with OpenView, below.

Verify that the name ServiceGuard Manager is listed in Start ->
Programs ->. Verify that a ServiceGuard Manager icon is on your
desktop.

If you are updating from an earlier version of ServiceGuard Manager,
your user preference files are replaced with default settings. The new
preference files are compatible with architecture changes in
ServiceGuard Version A.03.00 and A.03.00.01. Your old preferences
cannot be carried over

Installing with HP OpenView When you install ServiceGuard
Manager, it looks to see if you have installed one of these OpenView
products:

< NNM (Network Node Manager) Version 6.x or later
e ITO (IT/Operations) Version 5.3 or later (ITO includes NNM.)

= OpenView Operations Version 6.0. (OVO includes NNM.)
ServiceGuard Manager does not support VPW (Vantage Point for
Windows).

If you have installed any of these, the install process automatically does
these things:

= Adds a menu item and a button on the toolbar of NNM, ITO, or OVO
to start ServiceGuard Manager (“ServiceGuard Mgr Launcher”).
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Sends ServiceGuard events to be logged in the Event Log. The
ServiceGuard subagent is responsible for notifying the management
station when status or configuration changes. By default, it is
installed in /usr/lbinfemsnmpd

Adds ServiceGuard messages to the ITO or OVO Message Browser if
assigned, and in the NNM Alarm Browser.

Modifies the Event Configuration Tool so you can set up automatic
actions and filter ServiceGuard messages.

Lets you configure the data collection to get historical MIB data from
network nodes, including data stored in ServiceGuard MIB objects.
The ServiceGuard subagent services the ServiceGuard MIB objects.
By default, it is installed in /usr/lbinfcmsnmpd

Then the installation process looks to see if you have OVO or ITO
Version 5.3 or later. If so, it checks to see if you also have ClusterView.

If you do have ClusterView installed, no files will be overwritten. The
launcher will be installed, so you can open an instance of ServiceGuard
Manager from the OpenView menu.

If you do not have ClusterView, but you do have ITO or OVO, tools are
added to the Tool Bank, ready for an OpenView administrator to assign
them. These tools are listed below.

Assign these tools carefully. Some require root access to the
ServiceGuard nodes, and some can grant it indirectly.

ServiceGuard Mgr launcher: You can launch ServiceGuard Manager
from OpenView. ServiceGuard Manager is independent of OpenView.
It does not use the OV daemons or object database to discover the
configuration or status of clusters. Instead, it gets information by
connecting to ServiceGuard Version A.11.12 or greater; then
ServiceGuard goes out on its subnets and gathers the information.

Installs these Tools to work on a selected cluster node:
— HA Info Tools:

— Query Cluster Conf: uses cmquerycl to gather configuration
information

— Scan Cluster: uses cmscancl to display information about
cluster configuration, LAN cards, disks, and file systems.
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— View Cluster Binary Config: uses cmviewconf to see an
ASCII extraction of the binary configuration file.

— View Cluster Config: uses cmviewcl to see cluster
configuration and status of running clusters.

— View System Log: opensvi editor to view
Ivarladm/syslog/syslog.log

HA Admin Tools:

— Cluster Admin: opens SAM to the ServiceGuard cluster
administration section

— Cluster Config: opens SAM to the ServiceGuard cluster
configuration section

— Package Admin: opens SAM to the ServiceGuard package
administration section

— Package Config: opens SAM to the ServiceGuard package
configuration section

— Run Cluster: uses the cmruncl command to start a cluster
from the node you selected

— Halt Cluster: uses the sghaltcl  command (a variant of the
cmhaltcl command) to halt the cluster of the node you
selected

— Run Node: uses the cmrunnode command to join the selected
node to its cluster

— Halt Node: uses the cmhaltnode command to make the
selected node inactive in its cluster

Net Diag Tools

— View Interface Config: displays LAN interface configuration
parameters

— LAN Diag and Admin: launches the program lanadmin ,
which administers and tests the local area network.

— Scan LAN interfaces: uses lanscan to display information
about each LAN device that has software support on the
system.
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— IP Interface Stat: uses netstat  to display statistics for
network interfaces and protocols, as well as the contents of
various network-related data structures. (Choose options to
filter output.)

— LVM tools.

— View Logical Volumes: displays the logical volumes currently
configured

— View Volume Groups: uses vgdisplay  to show information
about the volume groups configured.

Uninstalling ServiceGuard Manager

Uninstalling from HP-UX On HP-UX, uninstall ServiceGuard
Manager by running this command:swremove B8325BA

After uninstalling ServiceGuard Manager, you can remove the
ServiceGuard Manager logs; if you are not going to re-install, you can
remove the entire directory (by default, iar/opt/sgmgr/ ). If you are
not going to re-install, you can also remove the preferences that are
stored in the user’s home directory, under the .sgmgr directory.

Uninstalling from Linux On Linux, uninstall ServiceGuard Manager
by running this command:

rpm -e sgmanager-A.03.00-1
or: rpm -e sgmanager-A.03.00.01-1

After uninstalling, you can remove the ServiceGuard Manager logs; if
you are not going to re-install, you can remove the entire directory (by
default, /user/local/sgmgr on Red Hat and /opt/sgmgr  on SuSE). If
you get a message about “unable to remove.” you can ignore the ones
about error messages. If you are not going to reinstall, you can remove
the preferences that are stored in the user’'s home directory, under the
.sgmgr directory.

Uninstalling from Windows On Windows, there are two ways to
uninstall ServiceGuard:

< From the Start menu, choose Programs -> ServiceGuard Manager ->
Uninstall.

< From the Start menu, choose Settings -> Control Panel ->
Add/Remove Programs. Select ServiceGuard Manager from the list.
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After uninstalling ServiceGuard Manager, you can delete the log files; if
you are not going to re-install, you can remove the entire directory:
C:\Program Files\Hewlett-Packard\ServiceGuard Managenlog

folder. If you are not going to re-install, you can also remove the user
preferences folder. By default, preferences are in: C:\Program
Files\Hewlett-Packard\ServiceGuard Managen\users

Removing ServiceGuard Manager - OpenView Integration In
addition to doing the swremove of ServiceGuard Manager, you need to
manually do the following things if you integrated ServiceGuard
Manager into OpenView.

< If you have NNM only (not OVO):

1. Remove event templates: Go to the NNM or ITO menu and select
Options -> Event Configuration. From the list, delete the
following event groups:

— hpEMSTraps
— hpmcMgmt Traps
— hpmcSGTraps

2. Remove SGMgr MIBs: Go to the NNM or ITO menu and select
Options -> Load/Unload MIBs:SNMP. Unload the following
MIBs:

— hp-cluster
— hp-sgcluster

< If you have OVO (which includes NNM):

1. Remove messaging: Go to the Message Group Bank, and delete
Message Group HA.

2. Remove templates and monitors: Open the Message Source
Templates window. By default, the following are visible on the
top level. Remove them:

— Syslog

— SG_check_cmsnmpd

— EMS SNMP Traps

— HA Cluster SNMP Traps

Chapter 1

31



ServiceGuard Manager Version A.03.00 Release Notes, Second Edition
Installing and Running ServiceGuard Manager

3. Remove Application Tools: From the Application Bank, remove
these tool groups:

— HA Info

— HA Admin
— LVM

— Net Diag

Uninstalling: Removing SNMP Trap Destinations If you are not
going to re-install, and you do not wish to receive SNMP traps anymore,
you need to “unset” the trap destinations on the sending nodes.

1. First get a list of the nodes that are sending traps to your computer.
Select Event Browser from the View menu. Click the Configuration
tab. Make a note of the nodes and IP addresses.

Notice that the configuration tab shows only the nodes in your
current map. If you have several subnets, connect to a server
(Cluster Object Manager) in each, and use the Discover All option.

2. Log in to each node and edit the /etc/snmpd.conf file to remove your
computer from the list.

3. Stop and re-start the SNMP Master Agent on the node.

a. Find the process ID number, using: ps -ef | grep snmp

The master agent will show as snmpd, and the subagent will
show as cmsnmpd

b. Stop that process, using: kill <pid>
c. Restart the agents.
Use: /shin/init.d/SnmpMaster start for the master agent

Use: /shin/lbinfcmsnmpd for the subagent.

Setting up ServiceGuard Manager

Making a Highly Available Connection

If you wish, you can create a ServiceGuard package that will keep the
connection between your monitoring station and the server highly
available. If there is a failure in the connection, you might see the
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“Connection Dropped” message flash momentarily, but ServiceGuard will
maintain your connection. It will fail the connection over from one node
in a ServiceGuard cluster to another node in the same cluster.

ServiceGuard Manager gets its information by connecting to a server
with ServiceGuard A.11.12 or later. A component of ServiceGuard, the
Cluster Object Manager, polls the available subnets to discover other
ServiceGuard objects. It collects status and configuration information,
and sends the information back to ServiceGuard Manager.

To set up the highly-available connection between ServiceGuard
Manager and server nodes in a cluster, follow these steps:

Create the package in a cluster with ServiceGuard. For viewing, use
ServiceGuard A.11.12 or later. For administration commands use
ServiceGuard A.11.14 or later.

See “Creating the Package Configuration” chapter in the ServiceGuard
manual. All ServiceGuard manuals are posted on the web and you can
view or print them there. Go to http://mww.docs.hp.com and click
High Availability; the products are listed alphabetically.

1. Get an IP address to use as the package’s relocatable address. You
can use nslookup to be sure the package name and IP address are
correctly associated in your DNS table.

2. When naming the package, choose one that your users will recognize,
such as Clus3Srvr . The first time a user opens ServiceGuard
Manager they will see the Connect dialog box. They can type this
name in for Server. After that, the name will appear in a list every
time that user opens ServiceGuard Manager.

3. Make only these two modifications to the package configuration file
template, and leave the defaults for the other fields:

= List the package nodes. For high-availability, it is best to list all
the nodes in the cluster.

= For the run and halt scripts pathname, specify the control script
name and path for the run and halt script. (The default path is in
the documentation.)

4. Open the control script template. Make just two modifications. These
will allow the connection between your client (ServiceGuard
Manager station) and the server (ServiceGuard A.11.12 cluster):
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= Insert the IP address associated with your package (the
package’s relocatable address).

e |nsert the address of the subnet.

Assigning and Configuring New OpenView OVO/ITO Tools

When you install ServiceGuard Manager, it checks to see if you have
OpenView OVO installed. If you do, it checks to see if you have the tools
listed in “Installing with HP OpenView” above. If you do not have those
tools, it installs them for you.

The ITO tools are installed like other OpenView applications: SD control
scripts place the files on the system and register both the back end and
the front end with OpenView. The OpenView configuration is customized
for user opc_adm only. The ITO Administrator is responsible for
assigning access privileges and responsibilities.

To Restore Default Configuration If the ServiceGuard Manager
configuration gets lost or corrupted, follow these steps to restore the
default configuration that came with ServiceGuard Manager:

1. Exit all ITO user sessions.

2. Stop the ITO server process with the /opt/OV/bin/ovstop opc
command.

3. Go to /opt/sgmgr/OV  and untar the configurations files in with the
tar -xvf ito-ux.tar command.

4. Go to /opt/OV/bin/OpC and upload the new configuration with the
opccfgupld -replace -subentity /opt/sgmgr/OV/SGOpC
command.

5. Stop and restart the ITO package with the /opt/OV/bin/OpC/opcsv
-stop and /opt/OV/bin/OpClopcsv -start commands.

Launching ServiceGuard Manager

You can starting ServiceGuard Manager directly from HP-UX, Linux,
and from Windows. You can also start ServiceGuard Manager from
within the HP OpenView and ServiceControl Manager applications.
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Launching ServiceGuard Manager from HP-UX

To launch ServiceGuard Manager, standalone, in HP-UX, go to the
ServiceGuard Manager directory (by default, /opt/sgmgr/bin ) and
enter the sgmgr or ./sgmgr command, plus any options you want. To see
the full command, enter man sgmgr . The options are also listed below in
sgmgr Command Syntax.

You can also create a script or alias that includes the options you want.

Launching ServiceGuard Manager from Linux

To launch ServiceGuard Manager in Linux, go to the ServiceGuard
Manager directory (by default, Red Hat is /usr/local/sgmgr/bin and
SUSE is /opt/sgmgr/bin ). (SUSE is available only in English.) Enter the
sgmgr or .J/sgmgr command, plus any options you want. To see the full
command, enter man sgmgr . The options are also listed below in sgmgr
Command Syntax

Launching ServiceGuard Manager from Windows
Here are 3 ways to launch ServiceGuard Manager in Windows:

< By default, a shortcut icon is placed on your desktop (labelled SG
Manager A.03.00 or SG Manager A.03.00.01). Click it to launch the
program. When installed, it has the simple command without
options. You will be prompted to enter the options once the program
opens. You can modify the icon’s properties to use any of these
options: your name, password, server to connect to, and clusters to
discover. If you want to modify it follow the steps below:

1. Right-click on the icon, then choose Properties from the popup
menu.

2. Add options to the command in “Target.” The options are listed
below in sgmgr Command Syntax.

It is best to put quotes around command and file path names;
Windows allows spaces and other characters in directories, and
that could cause parsing errors.

= From the Start menu, select Programs -> ServiceGuard Manager.
This launches the simple command, with no options.
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= Open a DOS window. At the DOS prompt, enter the SGMgrDOS.exe
command. Depending on your system path setup, you may have to
enter the SGMgr directory (by default C:\Program
Files\Hewlett-Packard\ServiceGuard Manager\bin). You can also
enter options, as listed below in sgmgr Command Syntax.

It is best to put quotes around command and file path names.

Launching ServiceGuard Manager from HP OpenView

Within OpenView, you can launch SGMgr from the menu bar or by
clicking the SGMgr icon.

Launching ServiceGuard Manager from ServiceControl
Manager

If you have ServiceControl Manager installed, you will find a
ServiceGuard Manager tool. Click this tool icon to launch the interface.

sgmgr Command Syntax

The basic command to launch ServiceGuard Manager in Linux or HP-UX
is sgmgr . In Windows, it is SGMgr.exe or SGMgrDOS.exe. The options are
listed below. If you do not mention an option with the command, you will
be prompted to specify it in a window after the interface opens.

= Toopen a saved (static) file:

— The -f <filename > option opens a saved .sgm file. Enter the
pathname of the saved file, in quotes. This option is not used with
any other options.

= Toopen a server connection and see a map that you can update;
repeat these options for each session:

— The -s <servername > option specifies a node with ServiceGuard
A.11.12 or later. Your ServiceGuard Manager session will
connect to ServiceGuard on this node. ServiceGuard will start an
Object Manager process to discover the other clusters on its
subnet, and report back their configuration and status
information.

— If you specify the -s option, you may also specify the -I
<username > option to give the logon name of a user on that
server.

36

Chapter 1



ServiceGuard Manager Version A.03.00 Release Notes, Second Edition
Installing and Running ServiceGuard Manager

— If you specify the -l option, you may also specify the -p
<password > option to give that user’'s password.

— The -c <clustername > option specifies the clusters you want the
server to discover. (The server can discover only the nodes on its
subnets.) These clusters will be displayed on your map, under the
session with the COM server’s name. Repeat the -c option for
several clusters in this server’s session.

— Specify -un TRUE to see the unused nodes discovered by this
server on the server’s subnets. These are nodes that have
ServiceGuard installed, but are not currently configured in any
cluster.

= To open another session, repeat these steps.

When the interface opens, you will see what you have chosen, and you
will be given a chance to fill in any options you have not yet chosen.

Using the Interface

When ServiceGuard Manager opens, you have a chance to choose
Connect or Open (unless you have already specified one in the command
line).

To get acquainted with the program, Open a supplied Example file.

To see your own clusters, use Connect. You need to have a logon for a
node that is running ServiceGuard A.11.12 or later. This will be your
server. It can discover clusters on its subnets, if it has node access
permission, as root, in cmclnodelist or .rhosts . If you want to also do
administrative commands, you need to log on, as root, to an HP-UX
server node that is running ServiceGuard A.11.14 or later. (See
“Required and Recommended Patches” in this document.)

Once you have a map in place, open Help. Open the Getting Started topic
from the Help window's Table of Contents in the left pane. Open the Map
Legend topic to interpret the colors.

There are Help topics about troubleshooting clusters and troubleshooting
ServiceGuard Manager itself.

Right click on a tree or map object, and choose “Properties of <object>"
from the popup menu. Each tab in Properties has its own Help button.
that briefly describes each property.
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Right click a tree or map object and look at the popup menu again. You
will see which administration commands can be done on this cluster
object at this time if you have root permission on an HP-UX server with
ServiceGuard A.11.14 or later. (See “Required and Recommended

Patches” in this document.)

38 Chapter 1



ServiceGuard Manager Version A.03.00 Release Notes, Second Edition
Patches and Fixes in this Version

Patches and Fixes in this Version

This section lists known patches, defects that have been fixed in this
version, and current known defects and workarounds.

Please consult the Release Notes for the language you will install, to find
information about language-specific patches, defects, and known
problems.

Required and Recommended Patches

This section lists patches required or recommended for ServiceGuard
Manager Version A.03.00 and A.03.00.01. This list is subject to change
without notice. Contact your HP support representative for
up-to-the-moment information. Patches can be superseded or withdrawn
at any time, so always be sure to check the status of any patch before
downloading it.

An updated list of patches is available on the Hewlett-Packard IT
Resource Center: http://itrc.hp.com (Americas and Asia Pacific) and
http://europe.itrc.hp.com (Europe).

In non-English locales, when installing on HP-UX 11.0 or 11.11, install
the TrueType Fonts patch:

- HP-UX11.0:
— Japanese: PHSS 26972
— Korean: PHSS 26974
— Chinese-Simplified: PHSS_ 26976
— Chinese-Traditional: PHSS 24937
— Font Server: PHSS_25091

< HP-UX11l.11
— Japanese: PHSS 26971
— Korean: PHSS 26973
— Chinese-Simplified: PHSS 26975
— Chinese-Traditional: PHSS 24977
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— Font Server: PHSS_25092

Before you use the Event Browser, install two patches on all HP-UX
nodes in the clusters that will send the SNMP traps to your
ServiceGuard Manager Event Browser. The patch numbers are:

= PHSS_26724 (for HP-UX 10.x)
= PHSS_26725 (for HP-UX 11.x)

ServiceGuard Manager installs its own JRE (Java Runtime
Environment). Check for defects for each platform’s JRE:

e On HP-UX PA, ServiceGuard Manager automatically installs JRE
Version 1.4.1_01.

< On Linux, ServiceGuard Manager automatically installs JRE
Version 1.4.1 01

< On Windows, ServiceGuard Manager automatically installs JRE
Version 1.4.1 01

Check your operating system for patches:

= For HP-UX, check patches at: http:/Ammw.itrc.hp.com (Americas
and Asia Pacific) or http:/Aww.europe.itrc.hp.com
(Europe).

=  For Linux, check patches at: http:/Aww.redhat.com

e For Windows PC, check Service Pack at:
http://microsoft.com/ms.htm

Fixed in Version A.03.00

The problems listed below were fixed for the A.03.00 release. The section
after this has a list of problems fixed in A.03.00.01, after the release of
A.03.00. To see what version you have, go to the Help menu and select
“About.”

e JAGad91137 - sgmgr can not handle cmdeleteconf

e JAGad90129 - On Linux, Japanese online help shows hyphens
rendered as square characters.

< JAGad82212 - On NT, you may see “lllegal Access Violation.” This is
a Java problem (Sun bug ID 4479199)
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JAGael1148 - Admin progress dialog unresponsive after
ServerProviderException error.

JAGael0859 - When saving a map as a .GIF or .JPG, a dialog box
pops up. The editable field for path does not work. (Java problem,
fixed.)

JAGae08747 - Setting trap destination requires you to restart
Master Agent. (Fixed with SNMP patch.)

Fixed in Version A.03.00.01(but not in A.03.00)

These problems are fixed in A.03.00.01, but not in A.03.00. To see what
version you have, go to the Help menu and select “About.”

JAGae50772 - Rendering issues for non-English locales running W2P
(English Version)

JAGae67232 - Right-click in tree may cause an exception

JAGae64679 - HP-UX/OpenView installation doesn't show IPv6
traps.

JAGae62189 - Incorrect specification of command in admin progress
dialogue: cmhaltcl instead of cmhaltnode.

JAGae55465 - sgmgr core dumps when executed by non-root user
(JRE directory problem).

JAGae51034 - Event notification not supported by SG 11.12 Object
Manager.

JAGae50988 - Trap status is given as “Trap Setting” if IP address is
unresolved.

JAGae50769 In Simplified Chinese locales on Windows, installer
renders buttons as squares.

JAGae50692 - Can not read sgm files saved from ServiceGuard
Extension for RAC.

JAGae50948 - SGMgr (cmsnmpd) reports node joined cluster when
node did not join. Event Browser reports “HA Cluster Node Joined
Cluster” when it should report “HA Cluster Node Up.” In A.03.00,
incorrect message appears in Event Browser.

JAGae50883 - Event Browser Time/Date sorting not working
correctly.
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Known Problems and Workarounds

The following lists known problems for ServiceGuard Manager, Versions
A.03.00 and A.03.00.01, at time of publication. This list is subject to
change without notice. Contact your HP support representative for
up-to-the-moment information. More recent information on known
problems and workarounds may be available on the Hewlett-Packard IT
Resource Center: http:/mww.itrc.hp.com (Americas and Asia

Pacific) or http:/Aww.europe.itrc.hp.com (Europe).

Some of these problems were fixed in A.03.00.01, but remain problems
for A.03.00. To see what version you have, go to the Help menu and select
“About.”

JAGae71073 - Help index search with “enter” key does not work
in Japanese and Korean

= What s the problem? ServiceGuard Manager freezes when the Enter
key after characters are entered into the online help’s Index Search
field. This happens only when using localized Japanese or Korean
interface.

< What is the workaround? Use the full-text Search instead of the
Index tab in Japanese or Korean online help.

JAGae69202 - Rarely, cannot start program when running on
SUuSE via ReflectionX

= What is the problem? Occasionally, an exception happens when using
ReflectionX to remotely start ServiceGuard Manager on SUSE Linux.
(SUSE Linux is supported for English only.)

= What is the workaround? This is related to a problem in the Java
Runtime Environment. There is no workaround. Often it will work if
you try again.

JAGae69297 - Man page formatting issue / only available in
English

< What is the problem? The sgmgr man page is not correctly formatted.
Also, the man page is not available in all of the languages that the
interface is available in.
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= What is the workaround? You can open the interface by entering
sgmgr (sgmgr.exe on Windows). You can specify all options after the
interface opens. The man page syntax is given in online help under
Using ServiceGuard Manager -> ServiceGuard Manager Command.

JAGae68450 - Sometimes map connecting lines between node
and package are missing

< What is the problem? Rarely, a cluster map is drawn with no lines
connecting a node to the packages running on it.

< What is the workaround? This will usually correct if the user changes
the view, and then returns.

JAGae67232 - Right click in tree may cause an exception (Fixed
in A.03.00.01)

< What is the problem? Commands do not always complete if user
right-clicks on an object that is not selected. Here is one scenario: A
new view opens and nothing on tree or map has been selected with a
left-click. The user then right-clicks on a node in the tree. The menu
pops up, and the user selects a command. However, the command
does not complete, and user gets an error message.

< What is the workaround? Before using the right-click popup menu, be
sure the cluster object is selected. When an object is selected, the
map shows a change to the area around it.

JAGae64679 - HP-UX/OpenView installation doesn’t show IPv6
traps (Fixed in A.03.00.01)

= What is the problem? IPv6 trap template should be overwritten when
ServiceGuard is installed on an OpenView system. However, it isn't.

< What is the workaround? There is not workaround. This is fixed in
ServiceGuard Manager A.03.00.01, but not in A.03.00.

JAGae67456 - Using RemoteX, “Save Map” creates empty file

< What is the problem? When using ServiceGuard Manager A.03.00.01
on Linux with XWindows or ReflectionX, saving map as .jpg or gif file
does not work. It creates a file of size 0.

e What is the workaround? Save file from local console.
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JAGae62189 - Incorrect executing command message in halt
node progress dialog (Fixed in A.03.00.01)

What is the problem? Halt node progress dialog says command
executing is cmhaltcl -v -f . It should say cmhaltnode -v -f

What is the workaround? There is no workaround. Realize that when
you halt a node, the progress dialog box will report it is halting the
cluster, even though it is halting the node as requested. Message
fixed in ServiceGuard Manager A.03.00.01, but not in A.03.00.

JAGae55465 - sgmgr core dumps when executed by non-root user
(JRE directory permission problem) (Fixed in A.03.00.01)

What is the problem? On some HP-UX systems, a JRE file permission
problem causes ServiceGuard Manager to core dump when a
non-root user opens the interface.

What is the workaround? Have an administrator log on to the HP-UX
system, as root. Go to the /opt/sgmgrijre/lib directory. Change
permissions: chmod 555 PA_RISC2.0

JAGae45299 - Printing Help pages may use 100% CPU

What is the problem? When trying to print a Help topic, CPU usage
may suddenly jump to 100% of capacity, and stay there.

What is the workaround? This is a known problem with Java (ID=
4768427).

JAGae51034 Event notification not supported by SG 11.12 Object
Manager (Fixed in A.03.00.01)

What is the problem? In A.03.00, if you connect to a server with
ServiceGuard 11.12, you will not be able to receive SNMP event
messages. Fixed in A.03.00.01"

What is the workaround? If you want SNMP events, connect to a
node that has a later version of ServiceGuard.

JAGae50988 - Trap status is “trap Setting” if IP address is
unresolved (Fixed in A.03.00.01)

What is the problem? Wrong message is given in A.03.00 if IP address
is unresolved.
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< What is the workaround? There is no workaround. Message fixed in
ServiceGuard Manager A.03.00.01, but not in A.03.00.

JAGae50883 - Event Browser Time/Date sort does not work
correctly (Fixed in A.03.00.01)

< What is the problem? More recent events were found in the middle of
the table, not at the top or bottom.

e What is the workaround? There is no workaround. Fixed in
ServiceGuard Manager A.03.00.01, but not in A.03.00.

JAGae50948 Event Browser reports “HA Cluster Node Joined
Cluster” when it should report “HA Cluster Node Up.” (Fixed in
A.03.00.01)

< What is the problem? In A.03.00, incorrect message appears in Event
Browser. Fixed in A.03.00.01.

< What is the workaround? Remember to substitute correct message.
To be sure you have correct status, check the node’s Properties.

JAGae50816 “Java Webstart not installed” message displayed
when using Netscape.

= What is the problem? The problems occurs when using Service
Control Manager 3.0 to launch ServiceGuard Manager for Netscape
6.0 or later. You see a message saying that Java Webstart 1.2 is not
installed, even when it is installed.

< What is the workaround? ServiceGuard Manager has incorporated a
workaround that will alert the user to the problem and offer a chance
to continue launching ServiceGuard Manager.

JAGae50813 Cannot launch ServiceGuard Manager 3.00 from
Service Control Manager 3.0

< What is the problem? When launching ServiceGuard Manager from
Service Control Manager, SCM searches the client system for version
1.2 of Java Webstart. If it does not find it on the system, it directs you
to install it. However, at the time of writing this document, Webstart
1.2 is not available on HP-UX.
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= What is the workaround? You cannot launch HP-UX ServiceGuard
Manager from Service Control Manager until HP-UX is compatible
with Java Webstart version 1.2. Check HP-UX for updates.

JAGae50775 In Traditional Chinese locale, in HP-UX, need to use
Java OOB tool prior to install

< What is the problem? Java performance is bad on HP-UX in the
Traditional Chinese.

< What is the workaround? Before installing ServiceGuard Manager on
Traditional Chinese version of HP-UX, HP recommends running the
Java Out-Of-The-Box tool to modify kernel parameters. Please refer
to http:/mww.hp.com/products1/unix/javal/java2/outofbox/
infolibrary/release_notes_java_oob.html

JAGae50774 In Traditional Chinese and Simplified Chinese, the
license agreement radio button text is illegible.

= Whatis the problem? In the installer, the Licence Agreement window
shows a radio button to check, confirming that the user agrees with
the license terms. The text is too small to be easily read in Chinese.

= What is the workaround? Remember that the first button says “I
accept the terms of the license agreement” and is checked by default.
The other button says “lI do NOT accept the terms of the license
agreement.”

JAGae50773 In non-English locales, installer shows “OK” in first
panel

= What is the problem? When installing Korean, Simplified Chinese,
and Traditional Chinese, the first panel in the installer gives the
customer the local choice in a pull-down menu. The button beside the
choose reads “OK” in all languages. This button should be localized,
but is not.

= What is the workaround? To proceed with install, press “OK.”
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JAGae50772 Rendering issues for non-English locales running
W2P (English Version) (Fixed in A.03.00.01)

< What is the problem? If ServiceGuard Manager is installed on an
English version of Windows 2P, certain non-English characters are
not rendered correctly.

< What is the workaround? HP recommends that non-English locales
install native versions of ServiceGuard Manager on native versions
of the Windows operating system, and not on English versions.

JAGae50769 In Simplified Chinese and Traditional Chinese
locales on Windows, installer renders buttons as squares. (Fixed
in A.03.00.01)

= What is the problem? When installing non-English versions of
ServiceGuard Manager on some English versions of Windows, the
installation buttons are incorrectly sized and difficult to read.

< What is the workaround? HP recommends that you only install the
non-English versions of ServiceGuard Manager on native versions of
Windows. If you do not match SG Manager and Windows locales,
remember the standard order of buttons is (from left to right): Quit,
Previous, and Next. To continue installing, click the right-most
(Next) button.

JAGae50746 “Include Unused SG nodes” button does not work in
Change Sessions dialog

< What is the problem? If you change “Include Unused SG nodes”
setting in the Change Sessions window, the change is often ignored.

< What is the workaround? Open a new session with the desired
setting for the unused nodes option.

JAGae50727 In non-English locales, typed characters not visible
in HP-UX

< What is the problem? When running non-English versions of SGMgr
on HP-UX, typed non-English characters are invisible in the input
text boxes. The characters can be read by the program, but not seen
by the user. This occurs in the text fields of Alerts: Search and Help:
search.
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What is the workaround? The computer is printing white characters
on a white background, making them invisible. Set the system colors
of the CDE Style Manager from the HP-UX toolbar. Choose a color
set with a black foreground color, like Alpine or Wheat.

JAGae5b0692 - Can not read sgm files saved from ServiceGuard
Extension for RAC (Fixed in A.03.00.01)

What is the problem? When saving an .sgm file of a ServiceGuard
Extension for RAC cluster, save does not work. A file is saved, but it
is not readable.

What is the workaround? There is no workaround for A.03.00.
Update the COM (Cluster Object Manager) to a version later than
B.02.02.

JAGae50336 Alerts Panel: package status unknown for some
newly added packages

What is the problem? Under certain circumstances, the Alerts
window can show status unknown for a package when it is first
added. It may stay that way through several updates.

What is the workaround? Double-check the map and properties. If
problem persists, disconnect the session and then reconnect.

JAGae50110 Welcome Dialog and others: Mnemonic underline
indicator can be incorrect in non-English interfaces

What is the problem? In non-English interfaces, the keyboard
mnemonics are indicated by underlining a letter in parentheses. This
indicates that the item can be accessed by holding the alt key while
pressing that letter. In some translations, the underline is misplaced.

What is the workaround? Use the letter in parentheses for the alt-key
short-cut, even if the underline has moved into a word.

JAGae50003 - SNMP Event Browser cannot be scrolled during
arrival of burst of events

What is the problem? In stress testing, if a large number of events
came in at once, the scroll bar became unusable as it tried to track
many rapid inserts to the list.
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< What is the workaround? Wait until the table finds a stable order.
Usually this will be just a moment after rush of new events calms.

JAGae49513 - Cluster Properties shows Rolling Upgrade = yes if
node version is unknown.

< What is the problem? It may be confusing to see Rolling Upgrade =
YES in the cluster property sheets, when the administrator believes
that a rolling upgrade is not in progress.

< What is the workaround? Realize that Rolling Upgrade says NO only
when ServiceGuard Manager can verify that all nodes in the cluster
have the same version. If ServiceGuard Manager cannot determine
the version of one or more nodes, it will report YES for Rolling
Upgrade.

JAGae48058 - View-Tree menu unclick does not remove tree.

= What is the problem? Session disconnects if trying to discover many
clusters with bad configurations.

= What is the workaround? There is no workaround.
JAGae42868 - File Chooser window for file Open and Save can be
slow to pop up.

< What is the problem? When you request to save or open a file, a
window pops up where you can enter the filename, or browse. It
sometimes takes a few seconds to appear.

< What is the workaround? Change your expectations, and allow extra
time for the window to open.

JAGae40370 - Alerts dialog Apply button should accept the Enter
key.

= What is the problem? You cannot use the Enter key to activate the
Apply button in the Alerts dialog box.

< What is the workaround? Use the mouse to click the button, or tab to
it to select it, then use the Return key to activate it.
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JAGad80600 - Certain progress messages are not localized.

What is the problem? ServiceGuard Manager displays progress
messages directly from ServiceGuard as administration commands
are processed. ServiceGuard does not localize these messages and
ServiceGuard Manager can only translate the start and end

messages for every admin operation. The intermediate messages are
only in English.

What is the workaround? There is no workaround.
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Software Availability in Native Languages

ServiceGuard Manager Versions A.03.00 and A.03.00.01 interface are
available in five language options:

< ABA American English
< ABJ Japanese

= ABO Simplified Chinese
= AB1 Korean

= AB2 Traditional Chinese

Please consult the Release Notes for the language you will install, to find
information about language-specific patches, defects, and known

problems.

The following ServiceGuard Manager Release Notes are available from
http://docs.hp.com . For localized documents, click the button on the
left.

< American English (B8325-90036)

« Japanese (B8325-90037)

« Simplified Chinese (B8325-90038)
< Korean (B8325-90039)

« Traditional Chinese (B8325-90040)
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